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Notice: Alicat Scientifi c, Inc. reserves the right to make any changes and 
improvements to the products described in this manual at any time and without 
notice. This manual is copyrighted. This document may not, in whole or in part, be 
copied, reproduced, translated, or converted to any electronic medium or machine 
readable form, for commercial purposes, without prior written consent from the 
copyright holder.

Note: Although we provide assistance on Alicat Scientifi c products both personally 
and through our literature, it is the complete responsibility of the user to determine 
the suitability of any product to their application.

The manufacturer does not warrant or assume responsibility for the use of its 
products in life support applications or systems.

For more information regarding this or any Alicat product, please contact us at:

Alicat Scientifi c, Inc
2045 N. Forbes Blvd.  Bldg. 103

Tucson,  Arizona  85745
USA

Ph: 520-290-6060
       888-290-6060
Fax: 520-290-0109

email: info@alicatscientifi c.com
Web site: www.alicatscientifi c.com

02/23/2006 Rev.0         DOC-FVISIONMAN
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Overview
Software
Alicat Scientifi c’s Flow Vision© software program is designed to have a simple, intuitive, user-friendly 
interface.  Flow Vision© has been written specifi cally for Alicat fl ow instruments to allow users to take 
the fullest advantage of their Alicat devices in a graphical environment.

Technical Requirements
 • Microsoft® Windows® XP
 • Microsoft® .NET Framework Version 1.1

(A copy of Microsoft® .NET Framework can be downloaded at:  http://www.microsoft.com/downloads/
details.aspx?Familyd=262D25E3-F589=4842-8157-034D1E7CF3A3&displaylang=en) 

 • 2 MB hard disk space
 • Available COM port that supports 19200 baud communications*
 

* Note: Many laptops are not equipped with serial ports. A virtual serial port can be created using a USB to 
Serial adapter.

Main Menu:
Flow Vision’s main menu consists of fi ve main categories:

• File
• Confi gure
• Capture
• Tools
• Help

From these fi ve categories you will be able to access all of the functions of Flow Vision.

Getting Started
Installing Flow Vision
To install Flow Vision from the CD:

1. Insert the CD into the CD/DVD drive
2. If the program does not start automatically, do the following:

a. In the Start menu, click on the ‘Run’ icon.  In the text box type ‘D:\setup.exe’, and click 
‘OK’ (if your CD/DVD drive is a letter other than ‘D’, replace ‘D’ with the letter that 
corresponds to your drive)  You may also use Windows® Explorer® to navigate to your 
CD/DVD drive contents and select ‘setup.exe’ from the Flow Vision fi le directory.

3. The installation will begin with a welcome screen.  Read the notes and the warning and click 
‘Next’ to continue.

4. Next choose the directory in which you would like the software installed.  
a. The default directory is C:\Program Files\Alicat Scientifi c, Inc\Flow Vision\  The 

destination path can be changed in the text box by typing the desired destination 
directory or choose ‘Browse’ to select a directory.  Select ‘Disk Cost’ if you would like to 
know how much hard drive space Flow Vision will occupy after installation.

b. Flow Vision can be installed for a single user on a computer or for anybody who uses 
the computer.  If you would like your login to be the only user, select ‘Just me’ or if you 
would like anybody who is logged into the computer to be able to use Flow Vision, 
select ‘Everyone’.

c. After you have selected your installation directory and defi ned who can use the 
software, click ‘Next’.



5

5. Flow Vision will show the installation progress.  Upon completion of the installation click 
‘Finish’.

Note: Flow Vision does not require a registration code and can be installed on other computers with 
the original installation CD with full functionality.

Starting Flow Vision
In the ‘Start Menu’ select the ‘Programs’ icon.  From the list of available programs highlight the ‘Alicat 
Scientifi c’ group and select the ‘Flow Vision’ icon.



6

Using the Flow Vision Software
Installing a Device
Connect your Alicat instrument to your computer’s serial communications port using an Alicat 
MD8DB9 or equivalent cable.  If you are not familiar with how to fi nd your computer’s serial 
communications port or if you are unsure whether your computer is equipped with this port, refer to 
the documentation supplied with your computer.

You may wish to use the ‘Advanced Options’ settings to tailor how Flow Vision searches for a device.

The ‘Advanced Options’ settings can be found in the ‘Capture’ menu in Flow Vision’s main toolbar.  
In the Confi gure menu select ‘Properties’.  This will bring up the ‘Properties’ box.  The ‘Advanced 
Options’ can be found at the bottom of the Properties box.

‘High Port’ and ‘Low Port’ will set the number of ports for Flow Vision to search.  Low Port is the fi rst 
port that Flow Vision will search.  Flow Vision will search each port sequentially thereafter unit it 
arrives at the high port number.  For example, if Low Port is set to 1 and High Port is set to 4, Flow 
Vision will start by searching port 1, followed by port 2, port 3, and last port 4.

Note: Leaving the default settings for high port and low port could result in Flow Vision spending 
a signifi cant amount of time searching ports for devices.  If you know which port the Alicat fl ow 
instrument is connected to, assign that port number as the high port and low port and Flow Vision will 
only search that port.  If you know that the Alicat device is in a specifi c port range, assign the high and 
low port to refl ect that range.

The ‘Character Delay’ allows users to set how much time Flow Vision spends searching for device 
letters.

‘Timeout’ allows users to set how much time Flow Vision spends accessing a port.

Choose ‘Apply’ to save your changes.

Starting a Session
With an Alicat device connected to your computer via the serial communications port, select ‘New 
Session’ from the ‘File’ menu in Flow Vision.  This process may take a few minutes to complete as 
Flow Vision will search the system for communication ports and installed devices.

If the device(s) and connection have not changed since the last time Flow Vision was run, choose 
‘Load Last Session’ to skip the port and device searching process.
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Once Flow Vision has established a connection with the device, a measured parameter screen will 
appear that resembles the display on the instrument.  (If the unit is a non-display model the measured 
parameter screen will still appear) 

If trouble is encountered in connecting, use the ‘Help’ function in the main toolbar to access an error 
log from Flow Vision.  Use of this log may be required when obtaining technical support from Alicat 
Scientifi c.

Device Confi guration
Choose the ‘Confi gure’ option from Flow Vision’s main menu to make functional changes to the 
device. 

Polling Rate
The ‘Polling Rate’ is the rate at which the computer queries data from the connected Alicat 
fl ow device.  The sensors in the Alicat device are sensing changes in temperature, pressure 
and fl ow hundreds of times per second.  The results of which are rapid, minute changes in the 
display of process conditions.  Changing the polling rate will either increase or decrease the 
number of times the computer will query the connected Alicat fl ow device for information.

 

Changing the polling rate will not affect the accuracy of the device, only the amount of data 
being received by the connected computer.
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Gas Select
All Alicat gas fl ow instruments come from the factory with 30 pre-installed gas calibrations.  
The gas calibration for the unit can be changed by selecting the ‘Gas’ submenu.  A list of the 
installed gas calibrations will be shown.  Simply choose the gas for which the unit should be 
confi gured.  The gas select screen does not apply to pressure and vacuum or liquid devices.

Totalizer
If the ‘Totalizer’ function is installed on the Alicat device, connected users can reset the totalizer 
by selecting the ‘Reset’ function in the ‘Totalizer’ menu.

Flow Tare
The installed device’s zero fl ow point can be reset by selecting the ‘Flow Tare’ function in 
‘Tares’ menu.

Set-Point Control
This function applies to Alicat controllers only.  Users can select the valve set-point for their 
Alicat Flow Controller by using the ‘Set Point’ menu.  There are selections for 100% (the % 
symbol is not required) of full scale fl ow and no fl ow.  If you want another percentage choose 
‘Other’.  When ‘Other’ is selected a text box will appear, in the blank space enter the desired 
set-pont as a percentage of full scale (again, the % symbol is not required). 

Data Capture
Flow Vision’s data capture feature allows for measured data from the connected fl ow instrument to be 
captured to either a .csv fi le or a .txt fi le.  The capture function is useful for analyzing fl ow data over a 
given period of time.

To start a capture, the capture parameters must fi rst be confi gured.  Start by choosing ‘Capture’ from 
the main menu and select ‘Capture Path’ to bring up the capture properties box. 

Begin by selecting whether you want to collect data from a single device or from multiple devices.  
In order to capture data from multiple Alicat devices, all the devices need to connected and 
communicating with the computer running Flow Vision.  To learn more about connecting multiple 
Alicat devices to a single computer consult the user manual that accompanied your Alicat device.

Select the types of data you would like to capture by selecting measured parameters listed inside 
the ‘Data Types’ box.  Simply click in the appropriate parameter’s check box.  The presence of a 
check next to a parameter will indicate that the data is selected for capture.  Choose ‘Apply’ to save 
changes.  

Note: Not all shown ‘Data Types’ parameters are applicable to all Alicat devices.

To select a capture path, type a destination folder and fi lename into the text box marked ‘Capture 
Path’.  You can also click the ‘Browse’ button to select an existing directory.
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Flow Vision Tools
Flow Vision has been outfi tted with a number of tools that make working with an Alicat fl ow device 
easier and more productive.  Flow Vision’s tool package allow users to run time based scripts and 
graph fl ow data.  For users who prefer command line communication, an ASCII terminal has been 
added to allow sending command line instructions to the unit.

Building and Running Scripts
The scripting system inside Flow Vision makes it very easy to send time based commands to Alicat 
fl ow instruments.  A script allows a user to pre-program a fl ow program for an Alicat device and 
walk away.  Without a script, a user would have to wait next to the unit with a stopwatch and send 
commands to the unit as time triggers pass.  A script does this automatically.

To build a script, fi rst select the Tools option from the main toolbar.  From that menu select the 
‘Scripts’ menu and choose ‘Launch ScriptBuilder’.  

To begin a script, make sure the unit identifi er listed in the ‘Unit’ box corresponds to the unit ID of 
the connected device.  If it does not, use the dropdown arrow to select the letter of the device for 
which the script is being written.  Next, select the ‘Time’, in seconds - relative to the start time of the 
script (0.0) , at which the script command should take place.  Last, enter the ‘Command’.  For your 
convenience, a ‘Quick Commands’ drop down menu lists the most commonly used commands.  After 
each command is selected be sure to click ‘Add Command’ to update the list.
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A fi nished script will look like this:

Once the script is completed, be sure to use save the script using the ‘Save’ function in the ‘File’ 
menu in the main toolbar.

The ScriptBuilder utility has it’s own main toolbar.  Choose the ‘Confi guration’ command to bring up 
the ‘ScriptBuilder - Confi guration’ box.
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The ‘Looping’ function will tell Flow Vision how many times to run the script from start to fi nish.  A 
setting of zero will allow the script run indefi nitely.

‘Wait Time’ will add a time delay between commands inside a script.

A script can be based on time or procedures.  The ‘Programming Type’ allows users to select if a 
script is triggered by time events or by programming events.

‘File Format’ allows users to build scripts that can be executed inside Flow Vision or by command 
line programs like HyperTerminal®.  A HyperTerminal® style script can be useful if a script needs to be 
written for an Alicat device connected to a computer that does not have Flow Vision installed.  To run 
a script in HyperTerminal®, please refer to your instrument’s operating manual.

Once you have completed your script, set the confi guration and saved the script, you can close 
ScriptBuilder.

To run a script, select the Tools menu in the main toolbar and in the Scripts menu.  Select ‘Run’.  
A folder box will appear asking you to select a script fi le.  Select the script fi le you built using the 
ScriptBuilder program.  

Once you have selected the fi le, Flow Vision will bring up a script box showing the command list and 
the time interval.  To start the script simply press the ‘Start’ button at the bottom of the box.

Once the ‘Start’ button is clicked Flow Vision will execute the script.  You can stop the script at any 
time by selecting the ‘Stop’ button that has replaced the ‘Start’ button.
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Graphing Flow Data
Flow Vision contains a graphing utility that allows users to visually track mass fl ow, volumetric fl ow, 
pressure, temperature, set-point or totalizer in real time.

To access the graphing utility select the ‘Tools’ menu from the main toolbar and choose the ‘Graph’ 
function.  The graphing box will appear.

If the range of the graph is not acceptable, select the ‘Confi gure’ menu from the main toolbar inside 
the graph box and choose ‘Auto-Size’.  When ‘Auto-Size’ is selected, Flow Vision will size the Y axis 
of the graph to maximize resolution of incoming data.

The ‘File’ menu from the main toolbar will allow graphing to be paused and restarted.  Users can also 
print graphs from the fi le menu.

The graphing parameters can be accessed using the ‘Properties’ function inside the ‘Confi gure’ menu 
in the main toolbar.  From here users can select if data is graphed from a single connected device or 
from all connected devices.  To set the max number of points to graph, enter that number in the text 
box next to ‘Max points to graph’.  Finally, choose which parameter you would like to graph.  Choose 
‘Apply’ to save your changes.
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Technical Terminal
The Technical Terminal is the command line interface for communicating with the Alicat unit 
connected.  To access the Technical Terminal select ‘Tools’ from the main toolbar and select ‘Terminal’ 
from the ‘Tools’ menu.

The Technical Terminal functions as a command line interface.  To see a list of commands, please 
consult the documentation that accompanied the Alicat fl ow device.

Note: Accessing the Technical Terminal will close Flow Vision and once the terminal is closed Flow 
Vision will have to be restarted.

Uninstalling Flow Vision
To uninstall Flow Vision use the Add and Remove Programs function from your Windows® control 
panel.  Flow Vision can be selected from the program group and uninstalled.  If you are unfamiliar 
with the Add and Remove Programs function of your Windows® software please consult your system 
administrator or refer to your Windows® operating manual.
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Troubleshooting and FAQs

Question or Problem Answer or Solution
My Alicat device will not connect 
to Flow Vision.

1. Check all connections between Alicat device and computer.
2. Make sure Alicat unit is powered.
3. Make sure Alicat unit communication is set to 19,200 baud.
4. Verify that the communication cable is built and installed 

properly.
5. Verify that a connection can be made with the computer 

using Windows® HyperTerminal® following the instructions 
in the manual that accompanied the fl ow device. 

Flow Vision will not start when I 
put the CD into my CD/DVD drive.

Your computer may not be able to run the autorun script.  
Simply run Flow Vision’s setup.exe program from the drive 
directory using Windows® Explorer®

Flow Vision will not install 
properly.

1. Verify that your computer meets the minimum requirements 
to run Flow Vision.

2. If your computer meets the requirements and the problem 
persists please contact Alicat directly for support.

I cannot load a previous session. Sometimes Windows® deletes the registry entry that saves the 
session information.  Simply start a new session.

The process information 
displayed on my Alicat device and 
on the Flow Vision screen don’t 
always match.

In the confi gure menu the polling rate will dictate how often 
the Flow Vision screen is updated.  If the setting is changed to 
‘Unrestricted’, Flow Vision will display data changes at a faster 
rate.

Flow Vision and the display on my 
Alicat device don’t always match 
at zero fl ow.

The Alicat fl ow device comes with programming to help 
stabilize the display at zero fl ow.  The Flow Vision display 
will not have this stabilization feature and will show minute 
fl uctuations at zero, while the device’s display will be a solid 
zero.  This slight difference in reading is normal.

I start a data capture and nothing 
happens.

Flow Vision does not alert you that a data capture has started.  
To verify that Flow Vision is capturing data select the ‘Capture’ 
menu from the main toolbar and ‘Stop Capture’ will show as the 
menu choice instead of ‘Start Capture’.

I can’t fi nd my captured fl ow data. The default fi le and directory for data capture is:
C:\Program Files\Alicat Scientifi c, Inc\Flow Vision\Capture.csv.  
To change the fi lename and save directory use the ‘Capture 
Path’ function in the ‘Capture’ menu.

I am trying to run a script but the 
program keeps asking for a fi le.

Make sure that you have run the ScriptBuilder utility and saved 
a script.  Point Flow Vision to the script that you saved and a 
‘Script run’ box should appear.
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I am trying to graph data but I 
cannot get the graph to show any 
data.

1. Make sure that the right parameter is being graphed.  To 
verify, use the properties box to select the desired graphing 
parameter.

2. Verify the graph range is correct.  If the range is too high or 
too low, correct the range using the ‘Auto-Size’ feature.

The technical terminal asks me 
if I want to close Flow Vision, will 
that break the connection to my 
device?

Your computer cannot maintain two connections so Flow Vision 
will close in order to run the Technical Terminal.  If you want to 
use Flow Vision again, simply close the terminal and re-launch 
Flow Vision.


